
Avrupa Bilim ve Teknoloji Dergisi 

Sayı. 14, S. 29-36, Aralık 2018 

© Telif hakkı EJOSAT’a aittir 

Araştırma Makalesi 
 

 

 

 
www.ejosat.com ISSN:2148-2683 

 

European Journal of Science and Technology 

No. 14, pp. 29-36, December 2018 

Copyright © 2014 EJOSAT 

Research Article 

 

 

www.ejosat.com  29  

Virtual lab for artificial intelligence controllers based speed control 

for induction motor  

Serdar Paçacı1, Okan Bingöl2  
1 Suleyman Demirel University, Department of Information Technologies Isparta, Turkey 

2 Applied Sciences University of Isparta, Faculty of Tecnology, Department of Electrical-Electronic Engineering, Isparta, Turkey 

(İlk Geliş Tarihi 13 Temmuz 2018 ve Kabul Tarihi 24 Ekim 2018) 

(DOI: 10.31590/ejosat.443601) 

Abstract  

Practical implementation has an important role in engineering education. Practical implementations, however, may not be possible in 

some situations, such as lack of physical possibilities, the presence of situations that may create risks during implementation, or place-

time dependence. So, package programs are developed for the virtual practical implementation experience. On the other hand, these 

tools may not be flexible and interactive enough for all branches of science. Therefore, in this study a virtual laboratory tool was 

developed for the speed control of an induction motor fed by a three-level inverter. The user can select proportional-integral, 

proportional–integral–derivative, fuzzy logic, artificial neural network, and neuro-fuzzy controllers for the speed controller. Different 

working conditions for the induction motor can be simulated and the outcomes can be observed by the users. The virtual laboratory 

had a flexible interface and it was written on Microsoft Visual Studio 2015 IDE using C# programming language on Windows 

Presentation Foundation infrastructure. 
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1. Introduction 

With the advance of technology, modern styles of lives of 

people have changed. As a result of this advancement, people 

have started to solve problems more effectively [1]. Engineering 

education, which has started at university, comprises lifelong 

learning and progress of practical application. Essential factors 

of this education are mathematics, physics, experiments and 

practical applications [2].  

Due to rapid progress and complicated nature of high-tech 

devices, operating laboratory has increased the cost and 

decreased flexibility [3]. Because of these reasons, many 

engineers carry out effective experiments by using information 

technology and simulation software. Virtual laboratory 

simulation software’s have many advantages; for example, they 

save money, provide flexibility, multi access, alteration in 

system configuration to users [4, 5]. Hence, these applications 

are very useful [6–15]. 

Induction motors are being used more commonly in industry 

compared to other electrical motors due to their strong and 

reliable structures, low costs and high inertia momentum, ease of 

control, low maintenance requirements and ability to work in 

dirty and dangerous environments [16]. In high performance 

induction motor drivers, indirect field-oriented control is being 

commonly used. In this control method, the variables should be 

known correctly [17]. In order to control a system, a suitable 

mathematical model of the whole system should be derived. 

Nonlinear systems cannot be completely mathematically 

modeled [18]. For this reason, fuzzy logic (FL), artificial neural 

networks (ANN), neuro-fuzzy (NF) and other similar smart 

control technics are powerful alternatives and they are being 

commonly used [19, 20]. 

Fuzzy Logic is based on the fuzzy set theory, fuzzy if–then 

rules, and fuzzy reasoning. Fuzzy logic implements a nonlinear 

mapping from its input space to output space by a number of if–

then rules [6, 18, 21]. ANN has the ability to learn, generalize 

and being adaptive. ANN has parallel and distributed 

information processing structures that were developed in 

inspiration with the human brain, which are connected to each 

other via weighted connections [22, 23]. Fuzzy variables can be 

adjusted by the expert via trial and error. Recently, these 

variables have been adjusted via ANN. This control type is 

usually named NF Controller (NFC). 

Recent years, thanks to rapid progress in capacity and 

frequency of semiconductor power devices, a lot of changes 

have occurred in the systems of industrial motor driver [24]. In 

consequence of these changes, multilevel voltage source 

inverters have emerged [25]. Multilevel inverters are used in 

applications requiring high power and high voltage. When 

multilevel inverters are compared with two-level inverter at the 

same switching frequency, harmonic components’ amplitude is 

low [26, 27].  

In this study, a virtual laboratory software was developed 

which the speed control of an IM which is being fed via a three-

level inverter was done via PI, PID, FL, ANN and NF 

controllers. SVPWM technique was used in the switching of a 

three-level inverter. The software was coded using C# 

programming language in Microsoft Visual Studio 2015 

environment. The virtual laboratory software has a flexible 

structure and a graphical user interface. The motor and controller 

parameters of the driver can be easily changed and the circuit 

responses to different working conditions can be observed via 

graphics. 

2. Indirect field-oriented control of the IM 

Indirect field-oriented control method is commonly used in 

high performance induction motor driver systems. Using this 

method, angular synchronous velocity of rotor flux vector can be 

obtained based on the summation of real angular velocity and 

calculated angular slip velocity [28]. Voltage equation of motor 

is given in equation 1, electromagnetic torque is given in 

equation 2, angular slip speed is given in equation 3 and the slip 

position of the rotor is given in equation 4.  
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Where Vd, Vq are voltages, ids, iqs are stator currents, idr, iqr 

are rotor currents in the stationary, Rs, Rr are stator and rotor 

winding resistances, Ls, Lr are stator and rotor inductance, Lm is 

mutual inductance, λdr, λqr is magnetic flux of the rotor, ωsl is slip 

angular speed, ωe is synchronous angular speed and ωr slip rotor 

angular speed, θsl, is slip position, θe is synchronous position, θr 

is rotor position and p derivative operator. Basic structure of 

indirect field-oriented control of IM supplied by three-level 

inverter is given in Figure 1. 

3. Three-Level Svpwm Inverter 

Three-phase systems can be transferred into two-phase plane 

α-β of 900 phase differences by using space vector method. 

SVPWM modulation is based on space vector representation of 

voltages in the plane of α-β [29]. This method can also be used 

in the control of three-phase voltage-source inverters. Three-

phase voltages produced by the inverter are shown as space 

vector reference voltage Vref on the α-β plane. This case is 

expressed mathematically on equation 5. 

0 2 /3 2 /32
( )( )
3

j j j
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        (5) 

The basic circuit diagram of the classical three-phase three-

level voltage-source inverter is shown in Figure 2. Three 

switching variables (a, b and c) can be assigned to the inverter. 

There are total of (n3 = 33 = 27) switching states in three-phase 

three-level inverter as each phase (leg) has three switching 

states. As seen in Figure 3, voltage vectors are positioned in 

various points of two nested hexagons and divided into four 

groups according to switching their states. These are (a, b, c), 

(ap, an, bp, bn) and (op, oo, on) voltage vectors. In Figure 3, 

hexagon has six sectors (A, B, C, D, E, F). In the same time, 
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there are four regions (1, 2, 3, 4) in each sector. The total number of regions in the hexagon is 24 [30, 31]. 

 
Figure 1. Indirect field-oriented control of IM. 
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Figure 3. Switching states of three-level PWM inverter.

4. Fuzzy logic, artificial neural network 

and neuro-fuzzy controllers 

4.1 Fuzzy Logic Controller 

Fuzzy logic was inspired and developed by the human 

reasoning and decision-making capability [32]. Today, it has 

found a very wide range of usage in different areas. A FLC 

consists of four units including a fuzzification, fuzzy inference, 

knowledge base and a defuzzification unit [14]. The block 

diagram of FL is shown in Figure 4a. The FL speed controller 

block diagram of the IM is shown on Figure 4b. 

4.2 The Artificial Neural Network Controller 

Artificial Neural Network have learning, generalization and 

adaptability features, and parallel and distributed structures, 

which allow their quick operation. They are used in numerous 

applications thanks to such successful features [33]. The weights 

between the layers as shown in the figure are generally 

initialized with small random values. This process allows ease in 

training networks. A multilayer feed-forward ANN is shown in 

Figure 5a. The ANN speed controller’s block diagram is shown 

in Figure 5b. 

 
Figure 4. a) FL block diagram  b) FL speed controller block diagram. 

 
Figure 5. a) A multilayer feed-forward ANN with one hidden layer  b) ANN speed controller block diagram. 
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4.3 Neuro-fuzzy Controller 

Neuro-Fuzzy concept emerged by combining the FL 

controller’s decision-making ability and the ANNs learning 

ability. Via this way, the systems controlled by FL obtained the 

learning ability of the ANN while ANNs obtained the decision-

making ability of FL controllers [34]. The NF controller 

presented in Figure 6 comprises 4 layers. 

The first layer is the input layer. In this layer, the weights are 

unity and fixed. The weight values in this layer are not changing 

[35, 36]. 

The second layer is the membership layer and the nodes on 

this layer represent the membership functions on the FL. 

Membership functions are being chosen as Gaussian 

membership functions. To find the input values of the nodes on 

the second layer, the equality shown in equation 6 is being used 

while the equality shown in equation 7 is being used to show the 

output value. In this equality, m shows the center of the 

membership function, and σ shows the width of the membership 

function or its standard deviation. 

 

2

2

( )

( )

II II

i j i jII

i j II

i j

x m
t


 


  (6) 

 exp( )II II

i j i jy t   (7) 

 

Figure 6. Neuro-fuzzy block diagram. 

The third layer is the layer on which the rule base for the FL 

controller will be adjusted. Each node on this layer represents a 

rule. The smaller one of the values arriving at the nodes on the 

second layer is taken as nodes input expression. The expression 

shown in equation 8 is used to calculate the output values of the 

nodes on layer three. 

 1 1min( , )III III III III

j k j k j ky t x x    (8) 

The fourth layer includes the defuzzification and deduction 

procedure used in FL controllers. For defuzzification, weight 

center method was used. Parameters a and b in the block 

diagram shown in Figure 6 are given in equation 9 and 10. The 

output of the fourth layer is as shown in equation 11. 

 1
1

n IV III
j jk jk
k

a w y


   (9) 

 1
1

n III
j jk
k

b y


   (10) 

 0 0

IV IV a
y t

b
    (11) 

The main purpose in using NFC is to adjust the parameters 

of the FL controller. On the second layer of NFC, the center and 

width values of the Gaussian membership function that is used 

as input membership functions are adjusted. Similarly, the output 

membership functions and rule base on the third layer are being 

adjusted [35]. For the training of NFC, the error value is 

expressed by E. Its calculation is shown in equation 12. In the 

equality, d represents the desired output, and y represents the 

network output. 
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The training is conducted from the fourth layer to the first 

layer. Since the output of the fourth layer is the output of the 

network, an error value is found on this layer. The propagation 

value is represented by 
0

IV  and its calculation is shown in 

equation 13. 
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The change calculation due to the error values of the weights 

are expressed as shown in equation 14. 
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Arrangement of the weights is as shown in equation 15. The 

l symbol in equation 15 shows the sample index and  show 

the learning ratio. 
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Since there is no weight value calculation in the third layer, 

only the error value coming from the fourth layer is being 

calculated. Equation 16 shows how to calculate 
III

jk . 
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The calculation of the error value 
II

ij  on the second layer 

is shown in equation 17. 
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On the second layer, the adjustment of both the center and 

width of the same membership function is done. Equation 18 

shows the change of the center value, equation 19 shows the 

change of the width value. 
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Calculated change values and center and width values are 

calculated as shown in equation 20 and 21. In the equations, m  

shows the learning ratio for center value and   shows the 

learning ratio for width value. 
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Figure 7 shows the NF speed controller block diagram that 

belongs to the IM. 
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Figure 7. Neuro-fuzzy speed controller block diagram. 

All controller input coefficients are defined as the speed 

error eω between the reference speed ωr
* and the actual motor 

speed ωr and as the change in speed error deω. Error of speed eω 

is calculated as given in equation 22. Change in speed error is 

calculated as given in equation 23. Output variable is chosen as 

the current moment component. The differential expression of 

the speed controllers in the computer application is given in 

equation 24. 
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The reference speed required at the ωr
*(t) t’th sampling time is 

the motor speed at the ωr(t) t’th sampling time, and the motor 

speed error deω at the eω t’th sampling time is the change in 

motor speed error at the t’th sampling time and eω(t-1) is the 

change at the motor speed error at the (t-1)’th sampling time. 

5. Virtual Laboratory 

The main window of the program is shown in Figure 8. 

Above the main window, “File”, “Options”, “Language” and 

“Help” menus are placed. Below the File menu, there are sub-

menus that enable transferring the data obtained from the 

program to outside the program or transferring data created 

outside the program to the program. In the Options menu, the 

main parameters of the program can be arranged. In the 

Language menu, Turkish and English can be chosen by the user. 

The Help menu provides information regarding how to use the 

program. 

The main window consists of two parts. This part provides 

the schematics for a diode-clamped three-level inverter circuits. 

On the circuit chart, which semiconductor power keys will be 

conducting and which ones will be cutting off during the 

simulation will be shown using different colors. Also, there is 

the SVPWM graphic which shows the reference voltage vector 

and PWM signals during the simulation. Furthermore, in this 

section, PI, PID, FL, ANN and NF options for choosing the 

controller and simulation control keys can be found. 

On the right of the main window; there is an interface where 

the IM and inverter parameter values can be entered, motor’s 

reference speed signal and the load values to be applied to the 

motor can be arranged. For the reference speed signal, there can 

be two choices: stable and variable. Furthermore, there is a 

similar option to choose how to load or unload the motor. 

Two different graphics windows were prepared for the 

simulation graphics window. For the first window, as shown in 

Figure 9a, PI, FL, ANN and NF controllers’ simulation graphics 

window is shown. In this window, the current, voltage, reference 

speed – real speed and moment graphics of the motor can be 

found in their respective order. The second simulation window, 

as can be seen in Figure 9b, is prepared for the FL controller. In 

this window reference speed – real speed, motor’s current 

graphics, speed-error-input-membership-function usage, speed-

error-change–input-membership-function usage, defuzzification 

and rule base usage graphics can be found, respectively. 

 
Figure 8. Main window. 

 

Figure 9. a) Simulation graphics window  b) FL simulation graphics window. 



Avrupa Bilim ve Teknoloji Dergisi 

www.ejosat.com ISSN:2148-2683  34  

 

 

Figure 10. FL a) Input parameters  b) Output parameters. 

 

Figure 11. NF a) Data input window  b) Modeling window. 

Figure 10a shows the window designed to adjust the FL 

controllers input membership functions and choosing 

fuzzification method. For each membership function, four 

different membership function type which is triangle, trapezoid, 

gaussian and sigmoid. 

Scaling factor parameters of the input membership functions 

are defined in this screen as well. Finally, in this section three 

different fuzzification methods that are Min-Max, Max-Product 

and Tsukamoto can be chosen. For output membership function 

of FL controller, adjustment of the rule base and choosing the 

defuzzification method, the window seen in Figure 10b is 

designed. In this window, the output membership functions are 

created and rule base is adjusted. Also, either one of maximum 

membership, average of the maximums, weight center and 

weight average is chosen as the defuzzification method. 

To adjust the NF controller, the data input window shown in 

Figure 11a is used. The “Add Data from File” button on this 

window is used to obtain training and/or testing data from files 

with txt, csv, xls and xlsx or from Microsoft Access data base. It 

is possible to transfer data from MS Sql Server to the program 

via the “Add Data from Database” button. The columns in the 

transferred data can be erased or additional columns can be 

added, the lines can be erased or new lines can be added. 

Furthermore, the data to be used in the training or in the tests can 

be chosen by the user. After the last column of the added data, a 

column named “Used” is automatically added. The value of this 

column expresses whether this data will be used in the training 

or not. It is not necessary to add data from outside the program. 

“Null Table” but-ton enables creation of training and/or test data 

over the program. 

After the data input is done, by using the window shown in 

Figure 11b, NF’s modelling is done. By using the “Model” 

button, the NF controller is modeled and is showed graphically. 

“Transmit to Fuzzy Logic Controller” button transfers all 

adjusted parameters as a result of the training to the FL 

controller. 

After the NF controller is modeled, the training procedure is 

carried out via the maximum iteration number and MSE (Mean 

Square Error) value chosen by the user. Figure 12a shows the 

window designed for the training of the NF controller. If the 

MSE value was not decreased as targeted at the end of the 

training, “Resume Learning” option is selected and “Start 

Learning” button is clicked to resume training with the 

parameters from the previous training. When the training is 

competed using the learning window designed for the NF 

controller, when the modelling window is returned to, the shape 

of the membership function with respect to the center and width 

values in the nodes that are located on the second layer and show 

the input membership functions in the FL controller is shown to 

the user. Furthermore, the weight values of the connections 

between the rule layer which is the third layer and output layer 

which is the fourth and the last layer is shown to the user when 

hovered over with the cursor of the mouse. And after the training 

stage, the response of the NF controller to the training and test 

data and error values can be seen in the test screen shown in 

Figure 12b. 

Menus that are similar to the NF controller are pre-pared for 

the ANN controller as well. Data input procedure, which is the 

first step in adjusting the ANN controller is done via the screen 

that is designed in the same way as the data input menu of the 

NF controller. For the second step, the menu shown in Figure 13 
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is used to model ANN. Here the user can add as many hidden 

layers as he/she likes and can also add as many cells to each 

hidden layer added. For each layer, either one of the sigmoid and 

bipolar sigmoid or linear activation functions can be chosen. 

 

Figure 12. NF NF a) Training window  b) Test window. 

After the ANN controller is modeled, the training procedure 

is carried on by using the user chosen maximum iteration 

number, MSE (Mean Square Error) value, learning coefficient 

and momentum coefficient. By using the training menu designed 

for the ANN controller, after the training is done, when the 

modelling screen is returned to, the nodes show the parameter 

values of the nodes when hovered over with the cursor of the 

mouse, and the weight connections show the weight values in 

the same way. After this stage, the user can test the trained ANN 

by using the “Test” tab. 

 

Figure 13. ANN modeling window 

6. Conclusions 

In this study, a virtual laboratory set was developed for the 

speed control of an IM being fed by three-level inverter. As a 

speed controller, PI, PID, FL, ANN and NF controllers were 

provided to the user to choose from. Before the user works with 

this set, he/she needs to have theoretical in-formation regarding 

IM, SVPWM and speed controllers. But no detailed information; 

regarding how to use the set, is required before using the set. So, 

the users do not waste time in learning how to use the set. The 

set has a flexible graphics interface. The user can change the IM, 

inverter and controller parameters with ease and simulate IM’s 

working under different working conditions. The set can be 

installed under Windows based operating systems (XP SP3 and 

later) and operate.  
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